# TABLE OF CONTENTS

**Internet/Network Connectivity** .................................................................................................................. 2  
What do I need to do before I connect my personal notebook computer in my residence hall room? ............................................................................................................... 2  

**The Landmark College Portal/Intranet** ........................................................................................................ 4  
Why should I log in? ........................................................................................................................................ 4  
How do I log in to 'the portal'?..................................................................................................................... 4  
Please change your password! ....................................................................................................................... 5  
Let the Portal Do Your Logins ..................................................................................................................... 6  
Add Some Bookmarks  .................................................................................................................................. 6  
Get Your Event Posted ................................................................................................................................. 7  
Bulletin Board User Guide ........................................................................................................................... 8  
What if I forget to log out? .......................................................................................................................... 10  
What if I leave the Landmark College pages and then come back to the home page? .................. 12  
What if I forget my portal password? ........................................................................................................ 10  

**Using IQ Web** ............................................................................................................................................... 10  
Logging In .................................................................................................................................................... 10  
Change Your Password ............................................................................................................................... 11  
Check Your Schedule ................................................................................................................................ 12  
Logout ......................................................................................................................................................... 13  

**Using the H: drive** ......................................................................................................................................... 14  
What is the H drive? .................................................................................................................................... 14  
How do I access my H drive? ....................................................................................................................... 14  
How do I save a document to my H Drive? .................................................................................................. 15  
How do I retrieve a document from my H Drive? ......................................................................................... 16  

**Using the Landmark College Email Program (Groupwise)** ...................................................................... 17  
The Client Version ....................................................................................................................................... 17  
How do I log on to the GroupWise Client version, read my mail, close the message and reply to a message? ........................................................................................................ 17  
How do I send a new message? ................................................................................................................... 18  
The Web Access Version ............................................................................................................................ 21  
How do I log on to the GroupWise Web Access version, read and send email? ............................. 21  
How do I make new folders in GroupWise WebAccess? ............................................................................ 24  
Email Policy .................................................................................................................................................. 26  
About Email Attachments ............................................................................................................................ 26  
How do I view an attachment? .................................................................................................................... 28  

**Sonic RecordNow! Quick Start: Backing Up a Data CD** ............................................................................. 30  
Why backup your data (such as files and applications)? ............................................................................. 30
Some advantages to backing up to a CD are: .............................................................. 30
Setting up RecordNow! .................................................................................................. 31

Technology Support Services...................................................................................... 35
Student Support Categories ......................................................................................... 35
Who is Responsible for What? .................................................................................. 36

Where are the Computer Facilities on Campus? ................................................. 36
Located in the Library ................................................................................................. 36
Other Computer Facilities on Campus: ................................................................. 36
Wireless Connectivity Areas: .................................................................................. 36

Technology Learning Services...................................................................................... 36

Computer and Network Use Policy ............................................................................ 38
INTERNET/NETWORK CONNECTIVITY

What do I need to do before I connect my personal notebook computer in my residence hall room?

Please read the following agreement:

- I acknowledge that my required notebook computer must match the minimum configuration set by ITS and conform to network standards for Ethernet 10Base T and wireless connections before I will be issued a network login and password.
- ITS will be responsible for the network connection through the wall jack. I agree that I will be responsible for any software changes that I make that may cause my computer to become inoperable on the network.
- I agree that I am responsible for all maintenance, repairs, or enhancements to my computer. I also agree that I may also need to refer to the appropriate end-user warranties and contact the manufacturer or vendor if I experiences hardware failures or incompatibilities with peripherals.
- I agree that I am required to purchase a Software Bundle for my personal notebook computer, and that I will not copy licensed software.
- I agree that I will not install server software on my personal notebook computer, and I will not allow my personal computer to be used as a server.
- I acknowledge that I will be disconnected from the Internet and the network if my computer is discovered to have a virus or worms.
- I agree to adhere to the Landmark College Computer and Network Use Policy at the end of this handbook.

Information on Residence Halls and Network Connectivity

Students in residence halls may connect their required notebooks to the Landmark College network in their residence hall rooms after the computer has passed the registration process. This means that they will have access to the Internet and, if possible, to their Home directory (H Drive).

Although Information Technology Services will make its best effort to assist students with this connection, there may be brands or models of computers or combinations of software that meet minimum requirements but simply will not work with the network.

Each residence room will accommodate one computer per student via our wired network connection. Wireless connectivity is also available in all residence hall rooms.
To connect to the network in your room, after Information Technology Services’ Orientation:
(You must have already set up a Novell password for this to work.)

First, set up your computer and connect it to the network jack in wall using a network cable NOT a phone cord (see Figures 1 and 2) or using wireless.

**Figure 1:** This is a network cable (available at the bookstore if you don’t have one).

**Figure 2:** This is a phone cord. The actual cable is thinner and the ends are smaller than those on a network cable.

1. Turn on your computer.

2. Type your username in the Username field. Hit the tab key.

3. Type the password you created in orientation into the Password field. Hit the enter key.

You are now connected to the network and able to open a browser to the Internet. You will not be able to browse the internet until your computer is registered on the network. If you purchased a computer through the notebook program your computer will already be registered.
THE LANDMARK COLLEGE PORTAL/INTRANET

The Landmark College intranet is our internal information system: https://intranet.landmark.edu, and has webpages and forms for many of the offices on campus. You can get a feel for what's on the intranet by checking out the sitemap. (see Figure 1)

Note: The Landmark College intranet is also available for your use off-campus.

Why should I log in?

The portal is the home page. If you login, you will get a more personalized experience. Some pages require that you log in. (e.g. housing request forms, surveys, ISIS)

- events are targeted to your audience (Students, Faculty, Staff)
- new links will show up on the left in ‘Quick Links,’ such as the Student Directory and ISIS.
- you can add Bookmarks
- it will log you in to campus password-protected applications like IQWeb, and WebCT (you don't have to remember all of the passwords if you're logged in to the portal).

How do I log in to ‘the portal’?

1. Go to intranet home page at https://intranet.landmark.edu
   Enter your Network username and password.

   If you do not remember your username & password (or they don’t work), use the “Click here if you've forgotten...” located just below the login boxes. (see Figure 2)
2. Click orange “LOG IN” button.

3. Page should now say, “Welcome, Your Name.”
   If it does not, use “Click here if you’ve forgotten your password” & it will be sent to you as an email in GroupWise.

If you want to change your password...

1. Log in, then click on ‘My Prefs’ in top right. (see Figure 3, #1)

2. Click into the ‘Portal Password’ box, then type in a password that you will remember (you can use the same one you used for the network). Do the same thing in the ‘Confirm Password’ box. (see Figure 3, #2)
   The password must be at least 6 characters and contain at least one of the following special characters: \ / : * < > | + = { } [ ] ! ~ $ % ^ ( )

3. If you would like to make visible (or remove) from the home page the Bookmarks, the Personal Notes, Google Search, or Dictionary, check or uncheck the boxes. (see Figure 3, #3).

4. Click orange Update User button to make these changes happen.
   You may have to scroll to see the button. (see Figure 3, #5)
Let the portal do your logins

The portal will ‘remember’ your password information to 2 programs, so that all you have
to do is click on the home page link to the program (on the right of home page, under
‘Internet Tools’):

1. **IQWeb** (the program where you get your schedule, and view the course catalog)

2. **ISIS** (info about you: attendance, visits to support centers, your schedule; some
   instructors will enter comments and grade info here as well.) An ISIS User Guide
   is available from Technology Learning Services, Library building.

For IQWeb you have to ‘tell’ the portal your password once in ‘My Preferences,’ then it will
be able to log you in (see instructions below)

For ISIS, login to the portal causes a link to ISIS to appear on the Left, under Quick Links.
There is no additional password to learn or ‘tell’ the portal. (For more on ISIS, see the ISIS
User Guide.)

---

**IQ Web (Schedule and Course Info)**

*Note: Updating an IQ Web username and password will only work if you’ve changed them in the security settings in IQ Web.*

- Username: amandabuzby
- Password: **********
- Confirm Password: **********

---

**Figure 4**

1. Go to ‘My Prefs’ page (see Figure 3, #1)
2. Scroll down the page.
3. For IQ Web click in the box next to password and enter the password for that
   program (see Figure 4).

   **Tricky part:** this won’t work until the password you enter here is actually the one
   set in the program itself. If you’re a student, you’ll probably set those passwords
   when you first use the program.

   **Easiest Solution:** Set these passwords all to the same thing. Easy to remember
   but hard for others to guess. When you first use those other programs, do ‘change
   password,’ and make it match.

4. Click on any orange Update User button on the page.
Add some Bookmarks

The portal will remember links to web pages for you. This is like using 'Favorites' in your browser, except that you can see them on any machine you go to, by logging in to the portal.

![Add/Edit a Bookmark](image)

**Figure 5**

1. Go to the web page whose link you want to add, e.g. [http://news.google.com](http://news.google.com).
2. Copy the address of the page: Click once in the URL/address bar (up top in the browser), so that it is selected. (Or drag over it with your mouse if necessary.)
3. Look at the menu items up top in the browser (e.g. File, Edit, View) and select Edit>Copy
4. Go to the intranet home page. ([https://intranet.landmark.edu](https://intranet.landmark.edu) or use your Back button)
5. Log in if you haven’t already.
6. Click on ‘Add’ on the left. (Figure 5, #1)
7. Next to ‘Link Title,’ type the name you want to appear in your Bookmarks list (e.g. Google News) (Figure 5, #2)
8. Next to ‘Link URL,’ click in the box and select Edit>Paste, as in Step 3. (Figure 5, #3)
9. Click the orange Update Bookmark button. (Figure 5, #4)
10. The link will now appear under My Bookmarks when you login, no matter what machine you go to.

Get your event posted

If you’ve got an event happening at Landmark College, use the portal to let people know! Click on the link on the home page just below the ‘events highlights,’ to use a form to submit an event posting request.

- Appropriate listings include announcements of college-related happenings.
- If it is not clear to the webmaster if an event is indeed 'appropriate', an associated division leader could be asked to sign off on the post.
- Events can be targeted specifically to: Students, Faculty, Staff, or any combination of those audiences.

If you’d like to post something more personal (ride request, lost item, rant about snow), try the bulletin board. (Link on right of home page, under ‘Internet Tools’). The title of your post will appear on the home page. See Bulletin Board User Guide as follows.
Bulletin Board User Guide

General

- Students, Faculty & Staff may register for the Landmark College Bulletin Board.
- We have 9 available 'forums' and are currently using 3: General, For Sale/Lost & Found, & Ride Board. While demand is low, an individual instructor or group could have their own forum. Students: if you have an idea for a board, contact Joanne, x6765, webmaster@landmark.edu
- No login is required to read posts (except for ISIS forum), but login is required to post anywhere. In order to login, you first must register.
- Registrants must use their GroupWise user name or their Full Name for the 'publicly displayed name.' (read more below under 'Registration Process'
- Bulletin Board Administrators and forum moderators can edit and delete posts and can ban individual users. This would only occur in the case of highly offensive posts.
- The subject line of 'Recent Posts' appears on the intranet home page.

Location

https://intranet.landmark.edu/bulletinboard.

There is a link to the bulletin board on the portal home page on the right hand side, under 'Internet Tools.'

Registration Process

To register, fill out the registration form. You will then receive an email with your username and password.

However, you will not be able to access the forum until your registration has been approved. (You will receive another email when that happens.)

1. Click on home page link to bulletin board and look for 'login or register' links. (Click on register)
2. Read agreement and click 'Agree.'
3. Registration Form opens
4. Login Name: Must be either your full name or GroupWise user name.
5. Publicly Displayed Name (will appear next to posts): Must be either your full name or GroupWise user name. If left blank, Login Name will be used.
6. Email Address: Does not have to be GroupWise email address.
7. Location, Occupation, Homepage, Interests, Your Picture, ICQ ID, AIM ID, and Birthdate, Signature, picture, and home page are all optional fields. If entered, they will be visible to other viewers in your profile. They can be added/edited by logging in and going to 'My Profile.' (link at top right of page)
8. The 'Preferences' features can be left as is. To learn more about some of the preferences, I recommend the FAQ. (e.g. you can find an answer to "What is a private message?")
9. Click 'submit registration.'
10. You will receive email with username and password, and warning that approval is necessary.
11. Webmaster receives email alert that someone has registered. Webmaster then goes to Control Panel and approves or declines the registration.
12. You then receive email with approval/denial. (It would only be denied if the names used don’t match the criteria listed above.)

Passwords

- Bulletin Board automatically assigns a stupid password—e.g. TYUIO
- You can change your password by logging in and going to 'My Profile' (link on top right)
- If you forget your password, click on login, then click on:
  “Lost Password? For assistance finding your registered login and/or password, click here.”
- Enter your email address and password will be emailed to you.
- If you enter the wrong email address, the bulletin board will say so. (Perhaps you registered with your hotmail address instead of your landmark.edu.)

To change your password:

1. Login to Bulletin Board
2. Click on My Profile on top right, under 'Landmark College Bulletin Board'
3. Click on 'View/Update Profile' on left under 'My Profile'
4. The password box is the first box as you scroll down the profile page.
5. Select over the current password and type in the new one.
6. Scroll to bottom of page and click 'Update Profile.'

To create a new post/reply to a post

1. Login to Bulletin Board
2. Click on the name of the forum that best relates to the info you’d like to post.
3. If you’d like to reply to a post, click on that post.
4. Click on the gray 'New Topic' button at the bottom of the Forum page. (or the gray 'Post Reply' button at the bottom of the post)
5. Enter subject and message and whatever additional options you choose, including “Email Notification” at the bottom of the page. (email notification means that if someone replies to your posts, you will be notified by email at the email address listed in your ‘My Profile’ page.)

Editing/deleting your posts

You can edit or delete posts that you have made. To edit/delete a post:

1. Log in to Bulletin Board
2. Navigate to the post you want to edit. (First choose the forum it is in, then the post itself.)
3. Click on the Topic Name.
4. At the top of each post is the date it was posted in red, followed by icons. Click on the icon with the pencil (the Edit/Delete icon).
5. To delete post, check the button near the top of the blue box.
6. To edit it, make changes within the body.
7. Click 'Edit Post' button to submit the changes.
What if I forget to log out?

If you leave Internet Explorer or Netscape open, your login will remain current for 20 minutes of inactivity. If you walk away from your machine, this is dangerous once because someone else could come to the machine and see your mail or your info in ISIS. [It's a good thing, though: you can surf the web and still be logged in when you're done with your research.]

If you close the browser (IE or Netscape) your 'session' will end. Whoever opens it next would need to log in.

What if I forget my portal password?

On the home page, under the login fields, there's a place to click if you've forgotten your password. The portal will then ask for your email address and send you your password.

USING IQ WEB

- IQWeb is an online program where you can check your course schedule and search for open course sections.
- IQWeb 'accounts' are created before you arrive, though schedules are not available until the Sunday before classes begin.

Logging In

1. There is a link to IQWeb on the portal home page (https://intranet.landmark.edu)

   Note: Hey, the 1st time you click on the link to IQWeb, do it while you are logged out of the portal! (Why? So the portal doesn't ask you for your IQWeb password before you set a new one.)

2. Click on the login key. (see circle in picture below)
3. Enter your **Network username** next to Login ID. (see picture below)

4. Enter your **Network username (again)** next to Password.

5. Click on the **Sign In** button.

---

**Change Your Password**

1. After you login, **click on the Change Password link** in the blue 'nav' on the left.
2. Enter your **Network username next to 'Current Password.'** (see picture below)

3. Enter a **password of your choosing next to 'New Password.'**
   Make life simple! Use the same password you use for GroupWise!

4. Enter your **new password again next to 'Re-enter New Password'**

5. Enter your GroupWise email address, so IQWeb can send you your password if you forget it. (This is required.)

6. Enter a **hint to help you remember your password.** Click **Change Password** to complete the process.

![Password Form](image)

**Check your schedule**

1. Click on the link to 'Course Schedule' on the left.

![Course Schedule Sidebar](image)

2. Choose whether you would like to **see your schedule as plain text** (#1 in picture below) or as a **grid** (#2).

3. **Click 'submit'**

![Course Schedule Form](image)
Picture of schedule as plain text:

<table>
<thead>
<tr>
<th>Session</th>
<th>Course</th>
<th>Title</th>
<th>Credits</th>
<th>Duration</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>MATH101</td>
<td>Multivariable Calculus</td>
<td>3.00</td>
<td>Jan 20, 2009</td>
</tr>
<tr>
<td>01</td>
<td>ENGR101</td>
<td>Mechanical Engineering</td>
<td>3.00</td>
<td>Jan 20, 2009</td>
</tr>
<tr>
<td>01</td>
<td>BUSN101</td>
<td>Introduction to Business</td>
<td>3.00</td>
<td>Jan 20, 2009</td>
</tr>
<tr>
<td>01</td>
<td>HMNT101</td>
<td>History of Western Civilization</td>
<td>3.00</td>
<td>Jan 20, 2009</td>
</tr>
</tbody>
</table>

Logout

Please click on the logout link when you are done! (see picture below)
USING THE H: DRIVE

What is the H drive?
Everyone has a limited amount of storage space on the network. This is called the H drive.
It is the best place to save documents, because you can access them from anywhere on campus without having to carry your laptop and floppy disks around. It is backed up every night, so if something happens to your computer, your work will not be lost.
Your H drive is big enough for 100 MB of data. If you exceed this limit, you won't be able to save anything more to your H drive.

How do I access my H drive?
1. Log on to the Network.
   Double click on the My Computer Icon on your desktop.

2. Scroll down so you can see the Network Drives.

3. Your username on Mako\Vol1\Students’ (H:) should appear in the Network Drives section. When you double click on this icon the contents of your H will be displayed.
How Do I save a document to my H Drive?

1. Be sure you are logged onto the network.

2. Open the document you wish to save. Go to File > Save As.

3. Click on the little black triangle drop down arrow in the rectangle with your name in it.

4. Double click on your username on Mako\Vol1\.....
5. Enter the name of the document in the File name: box and then click on Save.

How do I retrieve a document from my H Drive?

1. Be sure that you are logged onto the Network.

2. Double click on the My Computer icon on your desktop.

3. Scroll down to your H Drive (Your username on Mako\Vol1...). Then double click on that icon.

4. The contents of your H drive are now displayed. Select the document you wish to open.
USING THE LANDMARK COLLEGE EMAIL PROGRAM (GROUPWISE)

Landmark College uses the GroupWise email program. It has two versions you can use – the Client version (for when you are on campus) and the Web Access version (for when you are away from campus).

The Client version is installed on your machine, all public access, and all instructors’ machines. It is easier to use than the Web Access version because:

- it doesn’t time out when you are composing long email messages;
- you can archive important messages to your H drive;
- and the address book is easier to use.

To use the Client version, click on the GroupWise Client icon on the desktop (see Figure 1). For more help, there are printed tutorials in the Technology Support Center (Help Desk) on the second floor of the Library.

Figure 1: The Client icon

How do I log on to the GroupWise Client version, read my mail, close the message and reply to a message?

1. First you need to log onto the network and then click on the GroupWise icon (see Figure 1).

2. Notice your folders on the left hand side and the contents of the folders are on the right hand side of the window (see Figure 2).
3. To read a message double click on the message you want to read. This will open its envelope.

4. To close the message click on the Close button in the right hand side of the screen to close and save the message (see Figure 3).

5. To reply to a message, click on the message you want to reply to. Then click on the reply button, type out your reply, and then send it (see Figure 3).

How do I send a new message?

1. First, notice the 4 bars at the very top of the GroupWise window. The upper one has the menus for the actual GroupWise program where you can change your settings, set up rules, and change your password (see Figure 4).
2. The **second** toolbar across the top of the window contains tabs for quickly accessing your mail, calendar, contacts (addresses), and sent items (see Figure 5).

![Figure 5](image)

3. The **third toolbar** across the top contains icons for sending mail, appointments, tasks, accessing your address book, printing and finding messages, composing new mail, setting appointments, etc. (see Figure 6).

![Figure 6](image)

4. To send a new email click on the new mail icon on the tool bar (see Figure 6).

![Figure 6](image)

5. Enter the person’s name in the To: field.
Enter the subject of the message in the Subject: field,

Then, enter the text in the message box. When you are ready to send the message, click on the Send button (see Figure 7). Alright, you are on your way.

![Figure 7](image)
Hey, it’s good to know...

**To** is for the address of the person you are writing to.

```
To:  
```

You can send messages to more than one person by separating each address with a comma and a space:

pburke, charlesdickens

*Tip* If you are writing to someone at Landmark College, you do not have to include @landmark.edu in their address.

**CC** stands for Carbon Copy. You can send other people a copy of your message.

```
CC:  
```

**BC** stands for Blind Copy. You can send other people a copy of the message, but the people in the To and CC fields will not know that you did so.

```
BC:  
```

**Subject** is a standard convention in email to provide a subject to the message you are writing, so the people who receive it will quickly know what the message is about. This helps a lot when you are trying to organize your messages.

```
Subject:  
```

**Message** is where you type the body of the message. You can write very long messages here; the box will only show you part of what you’ve written.

You can also paste text written in another application (like Word) into this box. (Note: Web Access will time you out after 20 minutes of use. If you have a long message to compose, it’s best to compose it in Word, then paste it into your email message.)

```
Message:  
```

**One more thing**... when you are done reading and sending messages you can exit the program by clicking on the red X in the upper right hand corner of the GroupWise Window.
The Web Access version is found as a web page from a browser window (like Internet Explorer). You can access it through Landmark College’s intranet homepage (https://intranet.landmark.edu) or from the external (internet) Landmark College homepage (www.landmark.edu).

Figure 8: To get to the Web Access version of GroupWise from the intranet (http://intranet.landmark.edu) click on the GroupWise link to the right of the portal window.

Figure 9: To get to GroupWise Web Access from the internet (www.landmark.edu), find the login button at the bottom of the site’s home page.

How do I log on to the GroupWise Web Access version, read and send email?

1. First locate the GroupWise or Email login button on either Landmark College’s intranet or internet homepages (see Figures 8 and 9).

2. Type your login name (this is usually your full first name and last name) and then the network password that you set up when you first logged into the computer (see Figure 10).

Figure 10
Your mailbox will automatically be displayed (see Figure 11).

3. Notice on the left, you can see a display of all your Folders. On the right is a list of messages currently in your Mailbox.

   **Note:** Your mailbox shows you a list of all your messages. Messages remain in your mailbox until you move them to another folder. All messages are deleted from the server after 6 months.

   The envelope to the left of each message indicates whether you have opened the message yet. An open envelope means you have already read the message.

   The Date and time refer to when the message was sent, not when you received it in your mailbox.

4. To view a message, click on the Subject (see Figure 12).

5. To create a new email, click on the New... icon (letter with the pencil on it) up on the left hand side (see Figure 13). Choose Mail.
6. When you are ready to send your message, click Send (see Figure 15).

Figure 14: Here’s an example of the Mail Message window.

7. Click on the Old Sent Items folder to see the message(s) you have sent (see Figure 16).

Figure 15

8. To view mail you have received, click on the Mailbox icon on the left side toolbar (see Figure 17).

Figure 16

Figure 17
How do I make new folders in GroupWise WebAccess?

1. It’s easy...click on Manage Folders to create a new folder (see Figure 18).

![Figure 18](image)

2. Type in a name for the folder (see Figure 19). Click OK. Using the default settings places your new folder in the file cabinet.

![Figure 19](image)

3. To open the file cabinet, click on the arrow next to its name (see Figure 20). This expands the folder, so you can see your new folders inside.

![Figure 20](image)
4. To place one or more items in a selected folder, click on the box to the left of the message to select it (see Figure 21a). Then, choose Move from the main menu. Select the folder you want to move the file into (see Figure 21b) and your message will instantly move from your Mailbox to that folder.

Hey, it’s good to know what options are available on the menu bar at the top of the Web Access GroupWise page ...

These menu items apply to a specific message (piece of mail) you have selected in the mailbox viewing area.

- **Close** the message to return to your mailbox;
- **Next** advances you to the next message in the mailbox;
- Choose **Forward**, to forward a selected message to someone else;
- **Reply to Sender** replies to the person who sent you the message;
- **Reply All** replies to the person who sent you the message as well as all the other people who received the same message;
- You can also **Move** the message into a different folder;
  If you get a lot of email, it helps to organize your messages into folders (see section on 'How to make new folders in GroupWise').
- Choose **Delete**, to delete the message you are reading;
- **Read Later** reverts a selected message back to its unopened state (bold), an indicator to be read later.
- By clicking on **Properties**, you can see if the on campus message got delivered and opened.
Email Policy

The provisions of email service at Landmark College are listed in the complete policy. There are three parts of the policy that merit special attention in terms of unauthorized access or purpose and inappropriate content:

Unauthorized Access
The following constitute unauthorized forms of access:

- Permitting anyone else to send email using the username or email address that an email account holder has been given
- Sending email using another user’s username or email address
- Sending email from a unit username that an email account holder is not authorized to use
- Attempting to disguise the email address from which an email account holder’s message is sent or the identity of the sender

Unauthorized Purposes
The College’s email system is intended to support the College’s institutional activities and operational needs, and in principle, any other use is not permitted. In practice, limited or incidental use of email for personal purposes is regarded as acceptable, while use of email for the purposes listed below is not authorized:

- Private commercial use of the College’s email system
- Bypassing the compiled Faculty, Staff, and Students Messages that are sent in digest form
- Using email for any purpose which violates federal or state laws
- Using email for purposes that could reasonably be expected to cause, directly or indirectly, strain on the system, or interference with others’ use of email or email services

Inappropriate Content
Acceptable use of email is based on common sense, respect for others, and civility applied to the electronic communications environment. Moreover, it is important to note that the perception or reaction of the recipient is a major factor in determining if a specific communication is harassing, offensive, defamatory, or abusive. Various federal and state laws and College policies apply to this requirement.

About Email Attachments

Attachments are documents found on your computer that you can attach to and send in an email, like a photograph of your friends, your homework assignment, or your favorite MP3 song. Attachments can be a little tricky, however. You can attach files of any sort to messages. But there are some things to consider:

- **File Type** - Make sure the person to whom you are sending an attachment CAN OPEN IT - meaning they need to have an application that can read this kind of file. For instance, if you send someone a .pdf file - they need to have Adobe Acrobat, or some other .pdf-reading application to view it. You should always make sure the person to whom you are sending an attachment can read it. Not sure? Then ask them.
- **File Size** - If you send a file that is too large as an attachment, you can do damage to another person’s email account, computer or network - not to mention your own.
NEVER send anyone an attachment that is over 1 megabyte (that's 1,048,576 bytes).

- **Attachment Suspicion** - Many people will not open attachments they received without being warned before hand. Attachments may be corrupted, and do damage to your computer. Also, many computer viruses are spread through attachments. Remember the Love Virus? That moved around as an attachment. Viruses can get into your address book and send themselves to your friends without you knowing it. You should ask someone if it's ok to send them an attachment before doing so. That way, they know it's coming, and you'll know they'll be able to read it.

**How do I send an attachment using GroupWise Web Access?**

1. Click on the Attachments button (see Figure 22).

   ![Figure 22](image)

2. Then click on the Browse button (see Figure 23). The File Upload window appears.

   ![Figure 23](image)

3. Browse around on your computer to find the file you want to send. Once you locate it, click it so that it is highlighted (see Figure 24).

   ![Figure 24](image)
4. Click on the Attach Button (see Figure 25) and you will see the attachment you have found and are ready to send.

![Mail Message](image)

**Figure 25**

**How do I view an attachment?**

1. If you have received a message with a file attached, you see a paper clip next to the envelope (see Figure 26).

![Figure 26](image)

2. To view an attachment someone has sent to you, click on the red word View (Figure 27).

![Figure 27](image)

**Note:** If you were not informed of what an attachment contained before you received it, it is a good idea to check to see how large an attachment is before you open it. This is indicated near the paper clip icon, under the Subject area (see Figure 27). Notice that the attachment in the figure is 218,985 bytes. You may have trouble opening attachments that are over 1 megabyte (that's 1,048,576 bytes); this all depends on the speed of your Internet connection.

**Remember your password!** If you forget it, however... contact the Technology Support Center (Help Desk) at 6800 or techsupport@landmark.edu.
So you know, GroupWise is more than just an email program. It’s got lots of other features such as a Calendar, Environment, and Security settings. You can also use the program to schedule appointments, meetings and tasks for yourself or others.

All this extra stuff can be a little overwhelming at first...if you need help or would like some more in-depth training on the use of GroupWise contact:

Kathy Burris at TechLearning@landmark.edu; ext. 6892
Technology Learning Services, EAB
SONIC RECORDNOW!  
QUICK START: BACKING UP A DATA CD  
**FOR TOSHIBA & LENOVO NOTEBOOK OWNERS ONLY**

Why backup your data (such as files and applications)?

Backing up your files means making a spare copy (or 2) of every file and/or preference setting stored on your computer's hard drive which you have created or modified yourself. Backing up protects you from data loss in case your hard drive fails, and allows you to transfer old files to a new computer.

One way to back-up your data is to burn it to a data disc or CD. A data disc is a CD or DVD used to store electronic data, such as the files and applications that reside on your computer's hard drive. Unlike audio CDs, data discs are used to store files that are readable only by a computer. Data discs cannot be played on your home or car stereo — even if audio files are on the disc. (Extracted from RecordNow! Help files).

Some advantages to backing up to a CD are:

- A data CD can hold up to 700 MB of information (a lot of info! In comparison a floppy disc only holds 1.5 MBs of information) and can be accessed with any computer equipped with a CD-Rom drive.
- A data CD is portable. You can share the information easily, such as multimedia presentations, spreadsheets, graphics, and reports with friends, family, and colleagues.
- You can add or append information to a data disc again and again until it is full. If you're using rewritable discs (RW) you have the choice of appending or erasing and rewriting your disc.

Setting up RecordNow!

1. When first using RecordNow! you might be prompted to adjust the configuration of your Windows Media Player for greater playlist support when working with audio files (see figure 1). For purposes of this tutorial we are only working with data CDs and this setting can be bypassed for now.
   
   Choose> No.

   ![Figure 1](image)

2. Insert a data disc into your CD-Rom drive (#1. on figure 2), then click on the Data Disc icon (a yellow folder) from the tabbed list (#2. on figure 2).
3. Select the Data Disc icon to create or append to a data disc (see figure 3).

4. Click the Add Files and Folders button (#1 on figure 4). Search for the files/folders you would like to burn to the CD (#2 on figure 4). Click “Add” to add the files/folders to the list (#3 on figure 4).
5. As you add folders/files to your CD burning list, it calculates how much space will be used on the disc (#1 on figure 5). If the amount of files chosen goes over the amount of space available on the disc, it will indicate the “over” amount.

To remove files to stay within the allotted space or for any other reason, select the files in the file list and click the “remove” (red X) button (#2 on figure 5).

6. Check that your files are within the allotted space for the CD (#1 in Figure 6). If you burn the CD with extra space left you can continue to add files (append) the CD at a later time until the disc is full.

7. Name your CD – something intuitive – such as your name and the date. Keep the CD name short, like My_Backup0804, or Hartman2004 (#2 in figure 6).
8. Click the Burn button to start the back up of the files onto the CD (#3 on figure 6).

9. A progress bar will appear, indicating the time it will take for the information to burn to the disc (a great time for a bathroom or coffee break!). See Figure 7.

10. Once the CD is completed, you may close down the RecordNow! program. Check to see if your files are properly burned onto the disc, by opening the disc from My Computer (see figure 8).
Note: For further information on using Sonic RecordNow! visit the Help files within the program. See figure 9.
TECHNOLOGY SUPPORT SERVICES
http://intranet.landmark.edu/its/

Student Support Categories

IT support services for students fall into two categories: (1) Students who purchase a notebook computer through Landmark College’s Notebook Program and (2) Students who bring their own notebook computers to campus.

Service levels for these categories are as follows:

- Students who have purchased through the College’s Notebook Program are entitled to full software, hardware, and network support. This includes troubleshooting of hardware and Landmark College software. Students will also be entitled to a loaner while their computer is being repaired.

- Students who choose to bring their own computers that meet our minimum requirements, will receive network connectivity support. If the software bundle is purchased, those programs will be supported as well.

The Technology Support Center (Help Desk) is located on the second floor of the Library, room # 200. We are open Monday through Friday from 8:00 am – 5:00 pm.

If you need assistance configuring your PC for access to the Internet or our network, you must bring your notebook to the Technology Support Center (Help Desk). If you only want Internet connection from your room you must register your computer. If you want to connect to the Internet and have access to your network drives you will need to register your computer and have the Novell Client installed on your computer. We will test the connection to the network and Internet from our jack in the Technology Support Center (Help Desk) before you leave to ensure connectivity.

If you run into problems, please call us at extension 6800 or just stop by.

If you forget your passwords or have problems with your passwords, please call or stop by and we’ll be able to assist you in solving the issue.

Who is Responsible for What?

The College owns the Landmark College network – all the wires, cables, and routers that connect computers and peripherals to each other and, beyond the campus, to the Internet. The College determines who is authorized to use its network and can limit the nature of the use. Once you have connected your privately-owned computer to the network, the College supports your connection up to the wall jack in your room.

The College also owns all faculty notebooks, computer labs, computing sites, computers it places on its employees’ desks, and the software it has installed on them. The College determines who may use these resources and how they use them.
WHERE ARE THE COMPUTER FACILITIES ON CAMPUS?

**Located in the Library**

- Media Commons Area – 6 stations with multimedia tools, scanners, and network printers.
- Reference Center – 8 stations with research tools, printer
- LD Library – 5 stations with Kurzweil 3000 Professional, Read & Write Gold and 5 scanners
- Library Basement Lab – 16 stations with Kurzweil 3000 Read, Read & Write Gold, Adobe products and printer
- Two Laptop Stations with network connections on the first floor
- Sixteen Laptop Stations with network connections on the second floor

**Other Computer Facilities on Campus:**

- The Center for Academic Support, located on the 1st floor of EAB contains 8 computers equipped with assistive and multimedia software.
- Davis Lab on the first floor of Davis has 5 computer stations and a printer; it also has 5 laptop connections

**Wireless Connectivity Areas:**

- All classrooms on campus have access to wireless.
- The Library has wireless access on all floors.
- Student Center has access in Café Court.
- Admin auditorium and conference room has wireless.
- The East Academic Building has wireless access on all floors
- All residence halls have access to wireless in rooms and lounges

**Note:** It is not acceptable for faculty, staff, and students to leave a public lab or Library computer without logging off.

**TECHNOLOGY LEARNING SERVICES**

For training on Internet Research Tools, Online Databases, WebCat (the online library catalog), and other Research Tools, please contact Elizabeth Dolinger; her office is on the 1st floor in the Library, extension 1628, or ElizabethDolinger@landmark.edu.

The Technology Learning Center (TLC), located at the Center for Academic Support in EAB, contains graphics and assistive technology software, scanning, printing, and video dubbing equipment for your use. Training on basic computer skills, Kurzweil 3000, Dragon Naturally Speaking, Inspiration, PowerPoint, Word and GroupWise is available. Please visit the site on the Landmark College intranet at:

http://intranet.landmark.edu/its/services/technology_learning/

For technology learning assistance visit Kathy Burris in the Center for Academic Support or
in her office, 2nd floor of the Library). Or, call extension 6892, or email: TechLearning@landmark.edu.
I. Introduction

This acceptable use policy governs the use of computers and the network at Landmark College. As a user of these resources, you are responsible for reading and understanding this document. It is the policy of Landmark College that all members of its community act in accordance with these responsibilities and rules of conduct in the context of all existing laws (federal and state) and College regulations.

II. Rights and Responsibilities

Computing and networking resources at Landmark College are provided for academic and administrative purposes in support of the College mission. The College network and the Internet can provide access to resources on and off campus and the ability to communicate with other users worldwide. Such open access is a privilege and requires that individual users act responsibly. Users must respect the rights of other users, respect the integrity of the systems and related physical resources, and observe all relevant laws, regulations, and contractual obligations. Since electronic information is easily copied and reproduced, users must exercise care in acknowledging and respecting the work of others through strict adherence to software licensing agreements and copyright laws.

III. Existing Legal Context

All existing laws (federal and state) and College regulations and policies apply, including not only those laws and regulations that are specific to computers and networks, but also those that may apply generally to personal conduct.

Users do not own the computer accounts provided to them by the College, but are granted the privilege of exclusive use. The College does not intend to act as a censor of information but reserves the right to inspect files or e-mail and take appropriate action without notification if there is reasonable belief that there has been intentional or inadvertent disruption to the College's network or other shared resources or if there is suspected violation of College policies or applicable laws.

For example, system administrators may examine or make copies of files that are suspected of misuse or violation of these policies or that have been corrupted or damaged. User files may be subject to search by law enforcement agencies under proper procedures or when properly requested, subpoenaed, or ordered by a court. In addition, all messages created, sent, or retrieved over the Internet or the College's systems, including its mail systems, GroupWise, are the property of the College.
Any computer, networking device, telephone, copier, printer, fax machine, or other technology which is owned, licensed or leased by the College is subject to College policies. In addition, any technology which connects directly to College data or telephone networks, connects directly to a computer or other device owned or operated by the College and/or otherwise uses or affects College information technology facilities is subject to this computer and network policy.

Misuse of computing, networking or information resources may result in the loss of computing and/or network access. Additionally, misuse can be prosecuted under applicable statutes. Users may be held accountable for their conduct under any applicable College policies and procedures. Illegal production of software and other intellectual property protected by U.S. copyright law is subject to civil damages and criminal punishment including fines and imprisonment.

Other organizations operating computing and network facilities that are reachable via the Landmark College network or intranet may have their own policies governing the use of those resources. When accessing remote resources from Landmark College facilities, users are responsible for obeying both the policies set forth in this document and the policies of the other organizations.

IV. Enforcement

Repeated minor infractions or misconduct may result in the temporary or permanent loss of computer access privileges or the modification of those privileges. In addition, offenders may be referred to the appropriate College office for further action.

Any offense, which violates local, state, or federal laws may result in the immediate loss of all College computing and network privileges and will be referred to appropriate College offices and/or law enforcement authorities.

The College reserves the right to limit or restrict access to the Internet or to its network-based information technology resources on the basis of institutional priorities, bandwidth constraints, or College policies. The College also reserves the right to examine material stored on or transmitted through its facilities if there is cause to believe that the standards for acceptable and ethical use are being violated by a member of the College community.

Faculty, staff, and students should be aware that even when a message is erased or a visit to a Web site is closed, it is still possible to recreate the message or locate the Web site. Accordingly, all communications, including text and images, may be disclosed to College administrators or law enforcement officers without prior consent of the sender or the receiver.

Appendix A
Conduct Which Violates this Policy

It is not acceptable for faculty, staff, and students . . .

- To use a login name and password assigned to someone else.
- To use excessive network bandwidth. Bandwidth use is considered excessive when it affects the speed of the network for other users, or is well above average usage for extended periods of time.
• To violate copyright laws and their fair use provisions through inappropriate reproduction and/or distribution of copyrighted music, especially MP3 files, movies, computer software, images, etc.

• To use applications that hinder or interfere with the use of the network by others. For example, excessive use of applications that use an unusually large portion of bandwidth for extended periods of time (e.g., peer-to-peer network file sharing applications such as Napster, Gnutella, iMesh, Scour, etc. and network game servers such as Quake, Unreal Tournament, etc.).

• To use the campus network to gain unauthorized access to any computer systems.

• To connect unauthorized equipment to the campus network, this includes servers, hubs, switches and wireless access points.

• To attempt to circumvent data protection schemes or uncover security loopholes. This includes creating and/or running programs that are designed to identify security loopholes and/or decrypt intentionally secure data.

• To associate an unapproved domain name with a Landmark College owned IP address.

• To knowingly or carelessly perform an act that will interfere with the normal operation of computers, terminals, peripherals, or networks.

• To install personal software on a college-owned computer including applications, screen savers, and other utilities not sanctioned by the College.

• To knowingly or carelessly run or install on any computer system or network, or give to another user, a program intended to damage or to place excessive load on a computer system or network. This includes, but is not limited to, programs known as computer viruses, Trojan Horses, and worms.

• To deliberately waste or overload computing resources, such as printing too many copies of a document on College owned printers.

• To violate terms of applicable software licensing agreements or copyright laws.

• To use College resources for commercial activity, such as creating products or services for sale or hosting commercial web sites.

• To use electronic mail to harass or threaten others. This includes sending repeated, unwanted email to another user.

• To run, play, or download games on a public computer.

• To send unauthorized broadcast messages to all or part of the Landmark College community. Example: Sending a mass message to all faculty, staff, or students that bypasses the compiled Faculty, Staff, and Students Messages that are sent in digest form.

• To forge the identity of a user or machine in an electronic communication.

• To transmit or reproduce materials that are slanderous or defamatory in nature, or that otherwise violate existing laws or College regulations.
• To display sexually explicit or sexually harassing images or text in a public computer facility or location that can be in view of others.

• To attempt to monitor or tamper with another user's electronic communications, or read, copy, change, or delete another user's files or software without the explicit agreement of the owner.

• To use the system after employment has ended, student status has been terminated or system privileges have been suspended, curtailed or terminated, unless specifically authorized in writing.

• To damage, deface, alter, or remove any College computing equipment from campus without authorization.

• To leave a public lab or Library computer without logging out.